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Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of these
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for
any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other
intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade,
as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial
robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for
which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please
evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not
use Renesas Electronics products or technology described in this document for any purpose relating to military
applications or use by the military, including but not limited to the development of weapons of mass destruction. When
exporting the Renesas Electronics products or technology described in this document, you should comply with the
applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. Itis the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as
a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its
majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Code Generator) for RX together with the e’ studio IDE to create a working project for the RSK platform. It is
intended for users designing sample code on the RSK platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into e studio, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX231 microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX231 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’'s Manual Describes the technical details of the RSK RSKRX231 User’s Manual R20UT3027EG
hardware.
Tutorial Manual Provides a guide to setting up RSK RSKRX231 Tutorial Manual R20UT3032EG
environment, running sample code and
debugging programs.
Quick Start Provides simple instructions to setup the RSKRX231 Quick Start Guide R20UT3033EG
Guide RSK and run the first sample.
Code Generator Provides a guide to code generation in RSKRX231 Code Generator R20UT3034EG
Tutorial the e”studio IDE. Tutorial Manual
Schematics Full detail circuit schematics of the RSK. RSKRX231 Schematics R20UT3026EG
Hardware Provides technical details of the RX231 RX231 Group Hardware RO1UHO0496EJ
Manual microcontroller. Manual




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC Analog-to-Digital Converter

API Application Programming Interface

bps Bits per second

CMT Compare Match Timer

COM COMmunications port referring to PC serial port

CPU Central Processing Unit

DVvD Digital Versatile Disc

El Renesas On-chip Debugging Emulator

GUI Graphical User Interface

IDE Integrated Development Environment

IRQ Interrupt Request

LCD Liquid Crystal Display

LED Light Emitting Diode

LSB Least Significant Bit

LVD Low Voltage Detect

MCU Micro-controller Unit

MSB Most Significant Bit

PC Personal Computer

Pmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification

PLL Phase-locked Loop

RAM Random Access Memory

ROM Read Only Memory

RSK Renesas Starter Kit

RTC Realtime Clock

SAU Serial Array Unit

SCI Serial Communications Interface

SPI Serial Peripheral Interface

TAU Timer Array Unit

TFT Thin Film Transistor

TPU Timer Pulse Unit

UART Universal Asynchronous Receiver/Transmitter

USB Universal Serial Bus

WDT Watchdog timer

All trademarks and registered trademarks are the property of their respective owners.



http://www.digilentinc.com/index.cfm

Table of Contents

1Y oV 7
L1 PUIPOSE ... 7
A 11U | =T PP PP PP PP TTPPPPPPP 7
P20 111 0T 3 Tox 1 o o 8
3. Project Creation With €2 STUTIO............cveeeeee oot 9
R 70 R [ o1 1o T [V 1o o I PP PUPRRPT 9
3.2 Creating the PrOJECT ... ... ettt e e oo ekttt et e e e e e e s bt bb e e e e e e e e e sanbbneeeaaeeeaanne 9
4. Code Generation Using the €% Studio PIUG iN........c.cccievieoreeeeeeeeee e, 14
R [ 01 o To [1 1o 1o o 14
N e To (- 1= T 1T - (o] gl o | PRSP 14
B O To [ 1= T g 1T - i o] o B PRSP 16
43.1 (O [oTod [ ©T =T 01T - o] O TSP PURPP PP 16
4.3.2 La10=T 5 (0] o a0 a1 1o F=T L o RS 17
4.3.3 (@] 04 o T= L LIV F= L (od T T 1T 17
4.3.4 12-DIt AJD CONVEITET ....eteieeiitieee ettt ettt ettt ettt e sttt e e e sabe e e e e sabe e e e e smbe e e e e smbaeeesanbeeeesaabeeeesanbeeeenne 19
4.3.5 Serial CommUNICAtIONS INTEITACE .....coiiiiiiiiiie e 22
4.3.6 7@ 3 =0 T4 1= SR OUPRR SRR 26
4.4 BUIldING the PrOJECT ... ... ettt e ettt e e e e e sttt e e e e e e e s e aanbbe e e e e e e e e e nnbaneeaaaeeas 29
IO R 0o To [ [ 1 (=T o =11 (o) o FO PR SP 30
LT R I @1 Bl @fo o [N 11 C=To = 11T o TR PRRPP 30
511 1] o I 0o Lo [ PRSPPI 31
5.1.2 (@1 I IO To [ PRSPPI 32
5.2 Additional INCIUAE PANS ...ttt e e e e e s bbbt e e e e e e e e snbbaneeeaeeeaannes 33
LIRS A 111 (od s W @ To [N [ 1 (=To | = 11T o DT PRRPT 34
53.1 [a1=T 5 U] o] A 0o Lo [T PP TTT TP 34
5.3.2 De-boUNCE TIMEI COUE ... ...ttt e e e e e e st e e e e e e e e nabbeeeaaaeeas 35
5.3.3 Main SWItCH AN ADC COUE.......coiii ittt ettt e e e e e s e e e e e e e e e e s e ennbbeeeeaaeaas 36
L0 1= o 18 o [ @ o (=T [ 01 €= | = U1 o] o I USSR 40
LT T U 7Y = IO o o L= [ g1 1=Te | -1 1o o I O EER 40
5.5.1 L] O 1 oo [ USSP 40
5.5.2 MEAIN UART COUC ....eeiiiiiiiii ettt ettt ettt ettt e e sttt e s s bt e e e shbe e e e e sabe e e e s sabeeeesabbeeeesnnbeeeeanes 42
LN T I 1 I o o L= [ o1 (Yo = 1o T o OSSR 44
ORI T=T o0 To o[ To IR 1 g U= = (0] [T o 46

7. AAAItIONAl INFOIMALION <. e 48



LENESANS

RSKRX231
RENESAS STARTER KIT

R20UT3034EG0100
Rev. 1.00
Aug 24, 2015

1.0verview

1.1  Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to use the e? studio

IDE code generator plug in to create a working project for the RSK platform.

1.2 Features

This RSK provides an evaluation of the following features:
« Project Creation with e’ studio.

« Code Generation using the code generator plug in.
« User circuitry such as switches, LEDs and a potentiometer.

The RSK board contains all the circuitry required for microcontroller operation.

R20UT3034EG0100 Rev. 1.00
Aug 24, 2015 RENESAS

Page 7 of 52



RSKRX231 2. Introduction

2.Introduction

This manual is designed to answer, in tutorial form, how to use the code generator plug in for the RX family
together with the e’ studio IDE to create a working project for the RSK platform. The tutorials help explain the
following:

e Project generation using the e’ studio

e Detailed use of the code generator plug in for e studio
e Integration with custom code

e Building the project e’ studio

The project generator will create a tutorial project with two selectable build configurations:
e ‘HardwareDebug’ is a project built with the debugger support included. Optimisation is set to zero.
e ‘Release’is a project with optimised compile options, producing code suitable for release in a product.

Some of the illustrative screenshots in this document will show text in the form RXxxx. These are general
screenshots and are applicable across the whole RX family. In this case, simply substitute RXxxx for RX231

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the e? studio debugger, compiler toolchains or the E1 emulator. Please refer to the relevant user manuals for more in-

depth information.

R20UT3034EG0100 Rev. 1.00 ———r
Aug 24, 2015 RENESAS




RSKRX231 3. Project Creation with e’ studio

3.Project Creation with e studio

3.1 Introduction

In this section the user will be guided through the steps required to create a new C project for the RX231 MCU,
ready to generate peripheral driver code using Code Generator. This project generation step is necessary to
create the MCU-specific source, project and debug files.

3.2 Creating the Project

Start e” studio and select a suitable location for the project workspace

e Start e studio and select a suitable  [ie% Werkspace Launcher =
location for the project workspace. Select a workspace

e studio stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: | [SENYEIEERT - Browse...

[ Use this as the default and do not ask again

0K ] ’ Cancel

e In the Welcome page, click ‘Go to R e o o o e sleis
the workbench’. e

& RENESAS
e2studio
yerview = enesas Tulorials
. Renesas Samples What's New
- Try out the Renesas Samples Find out what is new
’ = i
e Create a new C project by right- [ Project Explorer 53 = <3==5 | :.
clicking in the Project Explorer pave
and selecting ‘New -> C Project’ as
shown. Alternatively, use the menu New » | FY% Project
item ‘File -> New -> C Project’. -
g2y Import & CProject
&y Export £ C++ Project
&1 Refresh F5 | Other. Ctri+M
R20UT3034EG0100 Rev. 1.00 RENESAS Page 9 of 52

Aug 24, 2015



3. Project Creation with e’ studio

RSKRX231
Enter the project name
‘CG_Tutorial. In  ‘Project type:’
choose ‘Sample  Project'. In

‘Toolchains’ choose ‘Renesas RXC
Toolchain’. Click ‘Next’.

In the ‘Target Specific Settings’
dialog, select the options as shown
in the screenshot opposite.

The R5F52318AxFP MCU is found
under RX200 -> RX231 -> RX231 -
100 pin.

Click ‘Next’.

C Project = @
C Project —
Create C project of selected type [
Project name: | CG_Tutorial|
Use default location
Chworkspace\CG_Tutorial Browse

Create Directory for Project

Project type:

Toolchains:

4 [= Executable (Renesas)
@ Sample Project

4 [= Static Library (Renesas)
& Sample Project

> = Debug-Only Project

» [ Executable (IAR)

> = Others

> 2= Makefile project

KPIT GMUARM-MNOME-EABI Toolchain
KPIT GMURLTE-ELF Toolchain

KPIT GMURX-ELF Toolchain

KPIT GMUSH-ELF Toolchain

Renesas RXC Toolchain

Renesas SHC Toolchain

Show project types and toolchains only if they are supported on the platform

@ < Back Net> || Finish ||  Cancel |
[e7 C Project o [@]=]
e2 studio - Project Generation p—
Select Target Specific Settings [
Toolchain Version:  [v2.03.00 -] g
Debug Hardware: [El (RX) v] -Q“q,
'-“ff;?&
Data endian : [Little-endlan data v] k
Select Target: R5F52318 AxFP

Select Configurations:

[¥] Hardware Debug : Debug using hardware
[7] Debug using Simulator : Debug using simulator
[¥/] Release (no debug) : Project without any debug information

Build configurations will be created in the project only for the selected debug mode
options, however by default the project will be built for the active configuration i.e.,
first configuration selected from group. Based on the device selection you made
(RX200) the debug hardware (E1 (RX)) and debug target (R5F52318 AxFP),debug

configuration will be automatically created for you.

‘@)‘ < Back H Next > I [ ] { Cancel
R20UT3034EG0100 Rev. 1.00 RENESAS Page 10 of 52

Aug 24, 2015



RSKRX231

3. Project Creation with e’ studio

e In the ‘Code Generator Settings
dialog, ensure the ‘Use Peripheral
code Generator’ is checked.

e Click ‘Next'.

e In ‘Select Additional CPU Options’
leave everything at default values.

e Click ‘Next'.

|8 € Project
e2 studio - Project Generation
Code Generator and FIT Settings

V| Use Peripheral code Generator

Use FIT module Download FIT modules

= [E]=]

The &2 studic peripheral code generator automatically generates programs (device drivers) for MCU peripheral functions (clocks,
timers, serial interfaces, A/D converters, DMA controllers, etc.) based on settings entered via a graphical user interface (GUI)
Functions are provided as application programming interfaces (APls) and are not limited to initialization of peripheral functions.
Conventionally, the information "CMCU initial settings", "How to define a target board", "File configuration”, "Names of
functions", "Common interface with user application” etc; has in many cases varied by sample code, so changes needed to be
made to sample code when embedding into a user application. With FIT, there are rules for this information, so each sample code
can be embedded into a user application with ease. Also, the peripheral function drivers and middleware which support FIT have a
common interface with user applications. This makes it easy to port user applications when migrating between RX
microcontrollers.

( User Application ]
Middleware
FIT
cG RTOS
Device Dyjiver Device Driver (BSP)
( MCU |
@ <Back || Met> |[ Fmsh |[ Cancel

C Project

e2 studio - Project Generation

Select Additional CPU Options |

Select Additional CPU Options:

Round: ’Nearest ']
Precision of Double: ’Single precision v]
Sign of Char: ’Unsigned v]
Sign of bit Field: [Unsigned -
Allocate from Lower Bit ’Lower bit v]
Width of Divergence of Function: [24 Bit ']

Specify Global Options:
[] Denormalized number allowed as a result

[] Replace from int with short

[] Enum size is made the smallest

[ Pack structures, unions and classes
[ use try, throw and catch of C++

[T] Use dynamic cast and typeid of C++

[] Saves and restores ACC using the interrupt function

® < Back ” Mext = | [ Finish J ’ Cancel

R20UT3034EG0100 Rev. 1.00
Aug 24, 2015

RENESAS
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RSKRX231

3. Project Creation with e’ studio

e In the ‘Global Options Settings’ leave
everything at default values.

e Click ‘Next'.

e Inthe ‘Standard Header Files’ dialog,
select C99 for ‘Library
Configuration’.  Untick ‘new(EC++)’
and leave all others at defaults.

e Click ‘Next'.

C Project E=R(EcE
e2 studio - Project Generation —(
Global Options Settings |
Patch code generation ’None v]
Fast interrupt vector register: ’None VI
ROM: ’None VI
RAM: ’None VI
Address (H'): 00000000
Address Register: IENone V]
@j < Back ” Mext > ] [ Finish ] [ Cancel ]
C Project

e2 studio - Project Generation
Standard Header Files

E=3 o8 >

Library configuration: | C{C99)

Select Header Files:

runtime : Runtime routines (Checked and disabled by default)
[ ctypeh : Character classification routines
[] math.h : Mathematical/trigonometric operations{double-precision)
[] mathf.h : Mathematical/trigonometric operations(single-precision)
[7] stdarg.h : Variable argument functions
stdio.h : Input/Output
stdlib.h : General purpose library features
string.h : String handling operations
[ ios(EC++) : Input/Cutput Streams
] : Memory allocation and deallocation routines

] complex(EC++)

: Complex number operations

[T] string(EC++) : String manipulation operations
] complex.h(C99) : Performs complex number calculation
[ ferw.h(C99) : Sets floating point environment
[[Jinttypes.h(C99) : Converts integer type format
[T wehar.h(C99) : Performs wide character
&} wetype.h(C939)  : Performs wide character conversion
Select All || Deselect All
@ <Bck || Net> |[ Enish [ Cancel
R20UT3034EG0100 Rev. 1.00 RENESAS Page 12 of 52
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RSKRX231 3. Project Creation with e’ studio

e In the next dialog, untick all check 7] C Project [o e
boxes except ‘I/O Register Definition
Files' as shown opposite. Click
‘Finish’.

el studio - Project Generation p—

Set various Stack Areas and to add additional Supporting Files |

Stack/Heap Cenfiguration
[ Use User Stack

User's Stack Size: (H") 100

Interrupt Stack Size: (H') 300

[ Use Heap Memory
Heap Size: (H') 400

Generation of Supporting Files

[¥]1/O Register Definition Files

Generate Hardware Setup Function | None -

@j Mext = [ Finish ] ’ Cancel

e A summary dialog will appear, click | summary =]
‘OK’ to complete the project et e

generaton. | PROJECT GENERATOR -------- -
PROJECT NAME : CG_Tutorial

PROJECT DIRECTORY : Chworkspace\CG_Tutorial
CPU SERIES : RX200

CPUTYPE: RX231

TOOLCHAIN NAME : Renesas RXC Toolchain
TOOLCHAIN VERSION:  +2.03.00

m

GEMNERATION FILES :

CAworkspace\CG_Tutorial\src\CG_Tutorial.c
Main Program
Ch\workspace\CG_Tutorial\src\dbsct.c
Setting of B and R sections
C:\workspace\CG_Tutorial\src\typedefine.h W
Aliases of Integer Type
Chworkspace\CG_Tutorial\src\iodefine.h -

4 3

Click OK to generate the project or Cancel to abort.

oK Cancel

R20UT3034EG0100 Rev. 1.00 RENESAS Page 13 of 52
Aug 24, 2015



RSKRX231 4. Code Generation Using the e’ studio plug in

4.Code Generation Using the e? studio plug in

4.1 Introduction

Code Generator is an e studio plug in GUI tool for generating template ‘C’ source code for the RX231. When
using Code Generator, the user is able to configure various MCU features and operating parameters using
intuitive GUI controls, thereby bypassing the need in most cases to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘r_cg_xxx.h’, ‘r_cg_xxx.c’,
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.
Within these code modules, the user is then free to add custom code to meet their specific requirement.
Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on
subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-visit
Code Generator to change any MCU operating parameters.

By following the steps detailed in this Tutorial, the user will generate an e’ studio project called CG_Tutorial.
The fully completed Tutorial project is contained on the RSK Web Installer
(http://www.renesas.com/rskrx231/install) and may be imported into e” studio by following the steps in the
Quick Start Guide. This Tutorial is intended as a learning exercise for users who wish to use the Code
Generator to generate their own custom projects for e studio.

The CG_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the
results via the Virtual COM port to a terminal program and also on the LCD display on the RSK.

Following a tour of the key user interface features of Code Generator in 84.2, the reader is guided through
each of the peripheral function configuration dialogs in 84.3. In 85, the reader is familiarised with the structure
of the template code, as well as how to add their own code to the user code areas provided by the code
generator.

The Code Generator installer is contained on the RSK Web Installer. This installer must be run before
proceeding to the next section.

4.2 Code Generator Tour

In this section a brief tour of Code Generator is presented. For further details of the Code Generator
paradigm and reference, refer to the Application Leading Tool Common Operations manual.

You can download the latest document from: http://www.renesas.com/applilet

Application Leading Tool is the stand-alone version of Code Generator and this manual is applicable to the
Code Generator.

From the e” studio menus, select ‘Window -> Open Perspective -> Other. In the ‘Open Perspective’ dialog
shown in Figure 4-1, select ‘Code Generator’ and click ‘OK’.

R20UT3034EG0100 Rev. 1.00 RENESANS Page 14 of 52
Aug 24, 2015
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RSKRX231 4. Code Generation Using the e’ studio plug in

Open Perspective = @

TR C/C++ (default)

e
#;f&Dehug
30 Git

) Planning

[’ Resource

EasvN Repository Exploring
E9Team Synchronizing

[ ok ][ canca |

Figure 4-1 Open Perspective Dialog

In the Project Explorer pane, expand the ‘Code Generator’ and ‘Peripheral Functions’ node. The Code
Generator initial view is displayed as illustrated in Figure 4-2.

[e*] Code Generator - €2 studio (=N
Eile Edit Navigate Search Project RenesasViews Run Window Help
= s R B R e e o Quick Access | £ | B &/Cr+ (FE Code Generator |
[ Project Explorer 52 9% ¥ = O | g Peripheral Functions 52 T GenerateCode 3] ¥ = O
|Z CG_Tutorial Release.launch - El”.loc:kseﬂmg;l Blockmagram‘ =t s
‘”tf’”l'h_“_ VCC setting
= .init . - -
oy e ©27(4)<VCC55(4) ©24(V) £VCC <27 (¥) © 1804 VEC <24(4) 2
4 %l Code Generator .
> A Pin View Main clock escillator and SSI clock (SSISCK) setting :
a5 Peripheral Functions [ Gperation /‘\
-
@ Clock Generator) Main clock oscillation source. Resonator - e
» W Voltage Detection Circuit =]
Wi Clock Frequency Accuracy Measurement Circuit Frequency 16 (MHz) 3
&/ Low Power Consumption Dscillator wait time B192cydes v 248 )
& Interrupt Controller Unit
» W Buses Oscillation stop detection function Disabled -
» @ 1/OPorts
, ' DMA Controller PLL circuit setting
' Data Transfer Controller [C] Operation
' Event Link Centroller Input frequency division ratio X112
& Mutti-Function Timer Pulse Unit 2 o
& Port Output Enble 2 multiplication factor x6
W' 8-Bit Timer g ney 48 (MHz)
» & Compare Match Timer
» W' 16-Bit Timer Pulse Unit Sub-clock oscillater and RTC (RTCSCLK) setiing
W Realtime Clock [F] Operatien
W' Watchdog Timer oscillator drive capacity Drive capacity for low CL
&' Independent Watchdog Timer
&' Low Power Timer 32768 (kHz)
Wi Serial Peripheral Interface e ek ascilntor (HOGCO) acth
= CRC Calculstor TR I YEEnT
. @ Serial Communications Interface B Cp=raiion
& 12-Bit A/D Converter Frequency 2 (MHz)
' 12-Bit D/A Converter Low speed clock escillator (LOCO) sefting
w Comparator B [¥] Operaticn
= DCBusTntedface —— ) T
&' Data Operation Circuit
- A . || -System clock seting il

CG_Tuterial/Code Generater/Peripheral Functions/Clock Generator

| T T T = —= ¥

Figure 4-2 Initial View

Code Generator provides GUI features for configuration of MCU sub systems. Once the user has configured
all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button, resulting in a
fully configured e” studio project that builds and runs without error.

Navigation to the MCU peripheral configuration screens may be performed by double-clicking the required
function in the Code Generator -> Peripheral Function on the left.

It is also possible to see a preview of the code that will be generated for the current peripheral function
settings by double-clicking the required function in the Code Generator -> Code Preview on the left.
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4.3 Code Generation

In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a UART.

4.3.1 Clock Generator

Figure 4-3 shows a screenshot of Code Generator with the Clock Generator function open. Click on the
‘Clock setting’ sub tab. Configure the system clocks as shown in the figure. In this tutorial we are using the
on board 24 MHz crystal resonator for our main clock oscillation source and the PLL circuit is in operation.
The PLL output is used as the main system clock and the divisors should be set as shown in Figure 4-3.

22 *Peripheral Functions 52 [ Code Preview [T Properties 7] Generate Code
" Clock setting | Block diagram |
VCC setting
@ 27 (V) VCC <55 (V) © 24(M) £ MEC €27 (W) © 1BV £VCC <24 (V)

Main clock oscillator and SSI clock (SSISCK) setting
Operation

Main clock oscillation source Resonstor -
Frequency e (MHz)
Oscillator wait time 28192 cycles - 2048 (ws)
Oscillation stop detection function Disabled -

PLL circuit sefting
Operatien

Input frequency division ratic =12 -
Freguency multiplication factor x135 -
Frequency 54 (MHz)

Sub-clock oscillator and RTC (RTCSCLK) setting
Operstion

Sub-clock escillator drive capacity Drive capacity for low CL -
Frequency 32762 (kHz)
High speed clock ascillator (HOCO) setting

[ Operation
Freguency 32 (MHz)

Low speed clock oscillator (LOCO) setting
[] Operation
Frequency 4 (MHz)

System clock setting

Clock source PLL circuit -

System clock (ICLK) =1 - 54 (MHz)

Peripheral module clock (PCLKA) =1 - 54 (MHz)

Peripheral module clock (PCLKE) x 112 -~ 27 (MHz)

Peripheral module clock for ADC (PCLKD) 21 ~ 54 (MHz)

External bus clock (BCLK) =12 - 27 (MHz)

Flash IF cleck (FCLK) =12 - 27 (MHz)
D T-dedicated low-speed clock escillator (IWDTLOCO) sefting

[7] Operstion

Frequency 15 (kHz)
USE-dedicated clock (UCLK) setting

[7] Operstion

UCLK cleck source USB-dedicated PLL clock

Frequency x3 48 (MHz)
LPT clock (LPTCLK) setting

[] Operation

Cleck source Sub-clock oscillator

Frequency x 172 16.384 (kHz)
BCLK pin output setting

[] Operation

Clock output source BCLK
CLKOUT pin setting

[] Operation PE3

Clock output source Main clock oscillator

Fregquency x 172 8 (MHz)

Figure 4-3 Clock setting tab
Proceed to the next section on the Interrupt Controller Unit.
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4. Code Generation Using the e’ studio plug in

4.3.2 Interrupt Controller Unit

Referring to the RSK schematic, SW1 is connected to IRQ1 (P31) and SW2 is connected to IRQ4 (P34).
SW3 is connected to directly to the ADTRGON and will be configured later in 84.3.4. Navigate to the ‘Interrupt
Controller Unit’ node in Code Generator and in the ‘General’ tab, configure these two interrupts as falling edge

triggered as shown in Figure 4-4 below.

ﬁ_gl *Peripheral Functions 52 | 2f Code Preview [ Properties

Fast interrupt setting

[] Fast interrupt Interrupt source | BSC (BUSERR vect=16)

Software interrupt setting

[7] Software interrupt Pricrity | Level 15 (highest)
MNMI setting
[] MMI pin interrupt Valid edge | Falling
IRQ0 setting
[C] 1RGO Pin | P30
alid edge | Low level
IRQ1 setting
IRQ1 Fin P31 -
Walid edge  Falling -
IRQZ setting
[C]1RQ2 Fin | P32
alid edge | Low level
IRQ3 setting
[C]IRQ3 Pin | F33
alid edge | Low level
IRQ4 setting
IRQ4 Pin P34 -
Walid edge  Falling -

Figure 4-4 Interrupt Functions tab

4.3.3 Compare Match Timer

Digital filter

Digital filter

Prionty

Digital filter

Prigrity

Digital filter

Prigrity

Digital filter

Prionty

Digital filter

Prigrity

Mo filter

Mo filter

Lewvel 15 (lighest)

Mo filter

Lewvel 15 (highest)

Mo filter

Lewvel 15 (lighest)

Mo filter

evel 15 (highest)

Mo filter

Lewvel 15 (highest)

(=]

(=]

(=]

(=]

(=]

(=]

ol

(MHz)

(MHz)

(MHz)

(MHz)

(MHz)

(MHz)

Navigate to the ‘Compare Match Timer’ node in Code Generator. CMTO will be used as an interval timer for
generation of accurate delays. CMT1 and CMT2 will be used as timers in de-bouncing of switch interrupts.

In the ‘CMTO’ sub-tab configure CMTO as shown in Figure 4-5. This timer is configured to generate a High
priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high

accuracy delays required in our application.

R20UT3034EG0100 Rev. 1.00
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"i_gl Peripheral Functions 52 5 Code Preview [ Properties ?ﬂ Generate Cade (2] 7 =

CMT0 | oMT1 | cMT2 | oMT3 | -

Compare match timer operation zetting

m

1 Unused @ Used

Count clock setting

@ PCLE/S ) PCLES32 ) PCLEA2E ) PCLE/M12

Interval value setting
Interval value 1

ms * [Actual value: 1]
Intermupt etting
Enable compare match interrupt [Ch10)
Priarity Lewel 10 -

4 L

Figure 4-5 CMTO tab

Navigate to the ‘CMTL1’ sub-tab and configure CMT1 as shown in Figure 4-6. This timer is configured to

generate a High priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in
this tutorial.

S8l Peripheral Functions 52 | 5 Code Preview [ Properties fi| Generate Cade 2] T = 8

| oMT0 | CMTT | owT2 | omTa | i

Compare match timer operation zetting

m

) Unuzed @ Used

Count clock, zetting

) PCLEAS @ PCLK/32 ) PCLEA 23 ) PCLEAAZ

Interval value zetting

Interval value 20 mz w  [Actual value: 20]
|nterrupt setting

Enable compare match interrupt [Ch11]

Frionty Level 10 -

4 I

Figure 4-6 CMTL1 tab

Navigate to the ‘CMT2’ sub-tab and configure CMT2 as shown in Figure 4-7. This timer is configured to

generate a High priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.
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Bl Peripheral Functions 52 2 Code Preview [ Properties % Generate Cone @] ¥ = O

| CMTO | CMT1 || CMT21 CwT3 | it
Compare match timer operation setting
) Unused @ Used

m

Count clock setting
() PCLE/E () PCLEA32 () PCLEAM 28 @ PLCLEA12

Interval value setting
Interval value 200 ms w  [&ctual value: 200.004267)

Interrupt zetting
Enable compare match intermupt [Ch1Z)

Pricirity Lewel 10 -

4 L F

Figure 4-7 CMT2 tab
4.3.4 12-bit A/D Converter

Navigate to the '12-bit A/D Converter’ tab in Code Generator. Refer to the screenshot shown in Figure 4-8 ,
Figure 4-9 and configure the S12ADO0 as shown. We will be using the S12ADO in 12-bit one shot mode on the
ANOOO input, which is connected to the RV1 potentiometer output on the RSK. The conversion start trigger
will be via the pin connected to SW3.
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jﬂ*l’eripheral Functions &2 -| Generate Code {a_l =

: General setting {| \indow Asetting | \Window B setting
- 512AD operation setting

@) Unused @ Used
- Operation mode setting
@ Single scan mode (@) Group scan mode () Continuous scan mode
- Double trigger mode setting
@ Disable (") Enable
~AJD cor ion select
@ High-speed ) Low-current
— Self diagnosis setting
Maode Unused -
Veltage used Use VREFHOxD

- Disconnection detection assist setting
Charge setting Unused -

Period 2ADCLK

— Group scan pricrity setting

Group A priority Group A without pricrity

Group B action Mot restarted or continued due to Group A priority

- AJD converted value count setting
@ Addition mode ) Average mode

— High-Potential reference voltage select
@ AVCCO () VREFHO

— Low-Potential reference voltage select
@ AVSSO ) VREFLO

~window function setting

@ Disable () Enable

— Diata storage buffer setting
@ Disable () Enable

— Analog input channel setting

Convert (Group A) Convert (Group E) Add/Average AD value

]

ANO30
ANO31
Temperature sensor output D
Internal reference voltage [

=

=

(-]
i

Figure 4-8 A/D Converter tab-1
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— Conversion start trigger setting
Conversion start trigger (Group &)
A/D conversion start trigger pin -
Conversion start tngger (Group B)
Compare match with or input capture from MTUD. TGRA -
ADTRGO# pin selection POT -
- Diata registers setting
AD converted value addition count 1-time conversicn -
Data placement Right-alignment -
Automatic clearing Disable automatic clearing -

— ANDOD | Self-diagnosis conversion time setting
Input sampling time 3667 (ps) (Actusl value: B)

—ANDD1 conversion time setting

Input sampling time |3.EE? | (us) (Actual value: )

- ANDD2 conversion time setting

Input sampling time |3.EE? | (ps) (Actual value: 5)

- ANDO2 conversion time setting

Input sampling time |3.EE? | (ps) (Actual value: 5)

- ANDO4 conversion time setting

Input sampling time |3.EE? | (ps) (Actual value: 5)

- ANDO5 conversion time setting

Input sampling time |3.EE? | (ps) (Actual value: 5)

- ANDDE conversion time setting

Input sampling time |3.EE? | (ps) (Actusl value: 5)

- AMNDOT conversion time setting

Input sampling time |3.EE? | (ps) (Actusl value: 5)

—ANDTE - AND31 conversion time setting
Input sampling time |3.EE? | (us) (Actual value: 3.667)

- Temperature sensor output conversion time setting

Input sampling time |5 | (ps) (Actual value: 5)

— Internal reference voltage conversion time setting

Input sampling time |5 | (us) (Actusl value: 5)

— Conversion time setting

Total conversion time (Group &) 4574 (us)
Total conversion time (Group B) | | (ps)
- Interrupt setting

Enable AD conversion end interrupt (AD1120)

Prionity Level 15 (highest) -

[¥] Enable AD conversion end interrupt for group B (GBADI)

Priority [ Level 15 (highest) -]
Figure 4-9 A/D Converter tab-2
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4.3.5 Serial Communications Interface

Navigate to the ‘Serial Communications Interface’ tab in Code Generator, select the SCI8 sub-tab and apply
the settings shown in Figure 4-10. In the RSKRX231 SCI8 is used as an SPI master for the Pmod LCD on the
PMOD1 connector as shown in the schematic.

-

24 Peripheral Functions 52 [ Code Preview [T Properties

scio | scn | scis | scis | scig | scis [ scn2
General setting | Setting

Function setting
(&) Unused
) Asynchronous mode Transmission
() Asynchronous mode (Multi-processor) Transmission
(7)) Clock synchronous mode Transmission
() Smart card interface mode Transmission
() Simple IIC bus
@ Simple SPI bus Master transmit only -
Fin setting
TXD8 PCT RXD8 PCE
S50A8 PC? S5CLE PCE
SMOsIgE  PCT - SMISO8 | PCE

Figure 4-10 SCI8 General Setting tab

Select the SCI8 ‘Setting’ sub-tab and configure the SPI Master as illustrated in Figure 4-11. Make sure the
‘Transfer direction setting’ is set to ‘MSB-first’ and the ‘Bit rate’ is set to 6750000. All other settings remain at
their defaults.
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E5l *Peripheral Functions 7 | ¥ Code Preview [ Properties
| scio | scin | scis | scie | sci8 | scis | sci2 |

General setting | Setting ‘

- Transfer direction setting
() LSB-first @ MSB-first
- Data inversion setting
@ MNormal ) Inverted
- Transfer rate setting
Transfer clock Internal clock || PCh -
Bit rate 6750000 - (bps) (Actual value: 6750000, Error : 0%)

[] Enable modulation duty correction

SCKB8 pin function selection Clock output -
- Clock setting
Clock delay Clock is not delayed -

[7] Enable clock polarity inversion

- Data handling setting

Transmit data handling Data handled in interrupt service routine -

- Interrupt setting
TXI8, TEI8 priority

Level 15 (highest) -

- Callback function setting
Transmission end

Figure 4-11 SCI8 SPI Master Setting

Staying in the ‘Serial Communications Interface’ tab in Code Generator, select the SCI5 sub-tab and apply the

settings shown in Figure 4-12. In the RSKRX231 SCI5 is connected via a Renesas RL78/G1C to provide a
USB virtual COM port as shown in the schematic.
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' ~i Peripheral Functions ¢

| scio | sci | scis |SCI6 | scie | scie | sCi12 |

General setting | Setting |

- Function setting

) Unused

@ Asynchronous mode
() Asynchronous mode (Multi-processor)
™) Clock synchronous mode

(") Smart card interface mode

Transmission/reception

Transmission

Transmission

Slave transmit’receive

Transmission

() Simple lIC bus

() Simple SPI bus
- Pin setting

TXD5 PAL

S5DA5 PA4

SMOSI5 PA4

- RXD5
S55CL5

SMISO5

Figure 4-12 SCI5 General Setting tab

Select the SCI5 ‘Setting’ sub-tab and configure SCI5 as illustrated in Figure 4-13. Make sure the ‘Start bit
edge detection’ is set as ‘Falling edge on RXD5 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings

remain at their defaults.
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ﬁg *Peripheral Functions 52 | 3 Code Preview [T Properties

| scio | sci1 | scis | scis | scis | sci9 | sciz |
| General setting | Setting |

- Start bit edge detection setting
) Low level on RXDS pin @ Falling edge on RXD5 pin
- Data length setting
) 9 bits @ 8 bits (@) 7 bits
- Panity setting
@ None () Even @ Odd
- Stop bit length setting
@ 1bit ) 2 bits
- Transfer direction setting
@ LSB-first ") MSB-first
- Transfer rate setting .
Transfer clock Internal clock | |PAl v|
Eit rate 15200 - (bps) (Actual value: 19176.136, Error: -0.124%)

[] Enable medulation duty correction

SCK5 pin function SCK5 is not used -
— Moise filter setting
[7] Enable noise filter
Noise filter clock Clock signal divided by 1 v | EVZ?'EI*E{’.-GC'D \ (Hz)
— Hardware flow control setting
@ None @ CTS ©) RTS
CTS5/RTSS5 pin PAS v
- Data handling setting
Transmit data handling Data handled in interupt service routine -
Receive data handling Data handled in interupt service routine -
~ Interrupt setting

|| Enable error interrupt (ERIS)
TXI5, RXI5, TEIS, ERI5 priority Level 15 (highest) -

- Callback function setting
Transmission end Reception end Reception error

Figure 4-13 SCI5 Asynchronous Setting
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4.3.6 I/O Ports

Referring to the RSK schematic, LEDO is connected to P17, LED1 is connected to P50, LED2 is connected to
P51 and LED3 is connected to P52. Navigate to the ‘I/O Ports’ tab in Code Generator and configure these
four 1/O lines as shown in Figure 4-14 and Figure 4-15 below. Ensure that the ‘Output 1’ tick box is checked.

This ensures that the code is generated to set LEDs initially off.

]

f,j} *Peripheral Functicns 5% | [ Code Preview [T] Properties

| Portd | Portl | Port2 | Port3 | Port4 | Port5 | Portd | PortB | PoriC | PortD | PortE | Portd |

-P12

@ Unused ) In @) Out Pull-up CMOS output C
-P13
@ Unused @ In @ Out Pull-up CMOS output 0
-P14
_—ELZ@" Unused 7 In ©) Out Pull-up CMOS output p
@ Unused ©In © Out Pull-up CMOS output t
-P16
@ Unused ) In © Out Pull-up CMOS output g
=P
) Unused i In @ Qut Pull-up CMOS output - Output 1 [] High-drive output

Figure 4-14 1/O ports — Portl

2 *Peripheral Functions 53 | f Code Preview [C] Properties

| Portd | Port1 | Port2 | Port3 | Port4 | Port5 | Pori | Porig | PoriC | PeriD | PortE | Portd |

-P50

) Unused @ In @ Out Pull-up CMOS output - Output 1 [] High-drive output
P51

) Unused @ In @ Qut F CMOS output - Output 1 [] High-drive output
-Ph2

) Unused @ In @ QOut Pull-up CMOS output - Output 1 [7] High-drive output
P53

@ Unused @ In @) Out P & p
-P54

@ Unused © In @ Out Pull-up CMOS output
- P55

@ Unused @ In =) Out F Dutp

Figure 4-15 1/O ports — Port5
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P33 is used as one of the LCD control lines, together with PE3, PE4 and PE7. Configure these lines as shown

in Figure 4-16,Figure 4-17 below.

25l *Peripheral Functions 2 | [f Code Preview [T] Properties

| Portd | Port1 | Port2 | Port2 | Forté | Port5 | Port | PortB | PortC | PortD | PortE | Ports |

P20

@ Unused @ In @ Out [JPull-up | CMOS cutput -] | Qutput T[] | High-drive out
- P21

@Umwsed ©in® ©Ou @ [JPulup  |CMOSoutput - "] Output1  [] High-drive outp
P32

@ Unused @ In © Out [JPull-up | CMOS cutput -] _|Output 1 [] High-drive output
_P33 _

) Unused @ In @ Out | Pull-up CMOS output - Output 1 [] High-drive output
P34

@ Unused @ In @) Out Pull-up ]CMOS output - \ [] Outpu [[] High-drive output
P35 _ -

@ Unused © In
P36

@Uwsed ©Oin® ©Ouw® [IPllup [CMOSoutput ~|  [OJ0utp
P37

@Uwsed Oy ©Ouw @ [IFulup [CMOSoutput ~]  OO0um

Figure 4-16 1/O ports — Port3

f,_}.! *Peripheral Functions i3 E’f Code Preview [ Properties
| Port | Port1 | Port2 | Port3 | Port4 | Ports | Porta | PortB | PortC | PortD | PorE | Portd |

@ Unused in © Out [] Pull-up CMOS output - | [ ] Outpu High-drive outp
PE1

@ Unused O In © Out [ Pull-up | CMOS output v| Outpy High-drive output
PE2

@ Unused “iln @ Out |Pull-up [ CMOS output ] [] Outp ) Hich- e o
_PE3 7

© Unused ® In @ Out ] Puli-up CMOS output - Output1  [T] High-drive output
_PE4

() Unused @ In @ Out [] Pull-up CMOS output - [[]Output1  [T] High-drive output
PE5

@ Unused ) in © Out [] Pull-up :CMOSoutput | [] Output [] High-drive outpu
_PES 7 :

@ Unused ® In ® Out JPul-up [ CMOS output - [] Outp [] High-drive outpu
FE7

() Unused @ In @ Out [ Pull-up CMOS output - Output 1 [ High-drive output

Figure 4-17 1/O ports — PortE
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Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘Generate Code’. The Console pane should report ‘The operation of generating file was successful’, as shown

Figure 4-18 below.

QOutput

[X|

M0403002:The generating source folder is: C:\wurkspace\CG_Iutnrial\Q
M0405001:The following files were generated:J
M0409004:cg_srchr_cg main_c was Dverwritten.J
M0409004:cg_srchr_cg dbsct.c was nverwritten‘g
M04039004:cg_srch\r_cg intprg.c was nverwritten_g
M0409004:cg_srch\r_cg resetprg.c was nverwritten.d
M0403004:cg_sre\r_cg_sbrk.c was nveruritten.g
M0409004:cg_srchr_cg vecttbl.c was nverwritten~g
M04039004:cg_src\r_cg_sbrk.h was nverwzitten.ﬁ
M0408004:cg_srchr_cg stacksct.h was nverwritten.g
M0408004:-cg_srchr_cg vect.h was nverwritten.g
M0405004:cg_srchr_cg hardware_ setup.c was nverwritten.#
M0409004:cg_srch\r_cg macrodriver.h was mvexwritten.g
M0403004:cg_src\r_cg_userdefine.h was cverwritten,g
M0403004:cg_src\r_cg_cgc.c was nverwritcen.g
M0409004:cg_sreh\r_cg cgc user.c wWas overwritten.J
M0405004:cg_srchr_cg cgc.h was Dverwzitten.d
M0409004:cg_srch\r_cg icu.c was Dverwritten.ﬁ
M0409004:cg_srch\r_cg icu user.c was nverwritten_g
M0409004:cg_srchr_cg _icu.h was nverwritten_g
M0409000:cg_sreh\r_cg port.c was generated.d
M0403000:cg_sre\r_cg port_user.c was generated-g
M0409000:cg_srch\r_cg port.h was generated_g
M0409004:cg_srchr_cg _cmt._c was nverwritten_g
M0405004:-cg_srchr_cg cmt user.c was nvezwritten.g
M040%004-cg_srehr_cg cmt . h was nverwritten.g
M0409000:cg_srchr_cg sci.c was genE:ated.J
M0403000:cg_srch\r_cg_sci_user.c was generatedAQ
M0409000:cg_src\r_cg_sci.h was generated..|
M040%8004:cg_srchr_cg_sliZad.c was nvezwritten.g
M0409004:cg_sreh\r_cg slZad user.c was ovezwritten.#
M0405004:cg_srchr_cg slZad.h was nverwritten-ﬁ
HM0405003:The operation of generating file was successful.J

[EQOF]

m

All Messages \ *Code Generator ,(: *Rapid Build /

Figure 4-18 Code generator console
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4.4 Building the Project

The project is template created by Code Generator can now be built. In the Project Explorer pane expand the
‘src’ folder. The three files created by the New Project Wizard in 83.2 have been excluded from the build
automatically as part of the code generation procedure as shown in Figure 4-19. This is because the main()
function now resides in r_cg_main.c in the cg_src folder and the type definitions and setting of sections has
been handled by the Code Generator.

7 Project Explorer B3 — <,1=’=f> |
4 =% CG_Tutorial [HardwareDebuqg]
» e Includes
4 [ sec
¢ [ Cg_src

> iodefine.h
[# CG_Tutorial.c
[# dhsct.c

] typedefine.h

Figure 4-19 Files excluded from the build by Code Generator

Switch back to the ‘C/C++' perspective using the gy C/C++ button on the top right of the e® studio
workspace. Use ‘Build Project’ from the ‘Project’ menu or the %' button to build the tutorial. The project
will build with no errors.
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5.User Code Integration

In this section the remaining application code is added to the project. Source files found on the RSK Web
Installer are copied into the workspace and the user is directed to add code in the user areas of the code
generator files.

Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for _xxxxx_. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Code Generator, if the user needs to subsequently change any of the Code Generator-generated code.

5.1 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK. Locate the files ascii.h , r_okaya_lcd.h,
ascii.c, and r_okaya_lcd.c on the RSK Web Installer. These files can be found in the Tutorial project for e
studio. Copy these files into the C:\Workspace\CG_Tutorial\src directory. The files will be automatically
added to the project as shown in Figure 5-1.
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Figure 5-1 Adding files to the project

In the e’ studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it. Insert the following #defines in between the user code delimiter comments as shown below.

/* Start user code for function. Do not edit comment generated here */
#define TRUE (€D

#define FALSE )

/* End user code. Do not edit comment generated here */

In the same folder open the file ‘'r_cg_main.c’ by double-clicking on it. Insert the following code in between the
user code delimiter comments as shown below.

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya_lcd.h"
/* End user code. Do not edit comment generated here */

Scroll down to the ‘main()’ function and insert the highlighted code as shown below into the beginning of the
user code area of the main() function:

void main(void)

{
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R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the debug LCD */
R_LCD_Init(Q);

/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSKRX231 ");
R_LCD_Display(1l, (uint8_t *)" Tutorial ');
R_LCD_Display(2, (uint8_t *)'" Press Any Switch ');
while (1U)

{

3

/* End user code. Do not edit comment generated here */

¥
5.1.1 SPI Code
The Okaya LCD display is driven by the SPI Master that was configured using Code Generator in 84.3.5. In

the e’ studio Project Tree, open the file ‘r_cg_sci.h’ by double-clicking on it. Insert the following code in the
user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */
MD_STATUS R_SCI8_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);
/* End user code. Do not edit comment generated here */

Now, open the r_cg_sci_user.c file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */
/* Flag used locally to detect transmission complete */

static volatile uint8_t sci8_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmitend call-back function for SCI8:

static void r_sci8_callback_transmitend(void)
/* Start user code. Do not edit comment generated here */

sci8_txdone = TRUE;
/* End user code. Do not edit comment generated here */

}
Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/

* Function Name: R_SCI8 SPIMasterTransmit

* Description : This function sends SPI8 data to slave device.
* Arguments : tx_buf -

* transfer buffer pointer

* t>x_num -

* buffer size

* Return Value : status -

*

MD_OK or MD_ARGERROR

/
MD_STATUS R_SCI8_SPIMasterTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
sci8_txdone = FALSE;

/* Send the data using the APl */
status = R_SCI8_SPI_Master_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci8_txdone)

/* Wait */
}
return (status);
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N

End of function R_SCI8 SPIMasterTransmit

/
This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.

5.1.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Code Generator in 84.3.3. Open the file r_cg_cmt.h
and insert the following code in the user area for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT_MsDelay(const uintl6_t millisec);
/* End user code. Do not edit comment generated here */

Open the file r_cg_cmt_user.c and insert the following code in the user area for global at the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8_t one_ms_delay complete = FALSE;
/* End user code. Do not edit comment generated here */

Scroll down to the r_cmt_cmiO_interrupt() function and insert the following line in the user code area:
static void r_cmt_cmiO_interrupt(void)

/* Start user code. Do not edit comment generated here */

one_ms_delay_complete = TRUE;

/* End user code. Do not edit comment generated here */

}
Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/
* Function Name: R_CMT_MsDelay
* Description : Uses CMTO to wait for a specified number of milliseconds
* Arguments : uintl6_t millisecs, number of milliseconds to wait
* Return Value : None
/
void R_CMT_MsDelay (const uintl6_t millisec)
uintlé_t ms_count = O;
do
{
R_CMTO_Start();
while (FALSE == one_ms_delay_complete)
{
/* Wait */
¥
R_CMTO_Stop(Q);
one_ms_delay_complete = FALSE;
ms_count++;
3} while (ms_count < millisec);
}
/
End of function R_CMT_MsDelay
/
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5.2 Additional include paths

Before the project can be built the compiler needs some additional include paths added. Select the
CG_Tutorial project in the Project Explorer pane. Use the @ button in the toolbar to open the project settings.

Navigate to ‘C/C++ Build -> Settings ->Compiler -> Source and click the | button as shown in below in

Figure 5-2.
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Figure 5-2 Adding additional search paths
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In the ‘Add directory path’ dialog, click the ‘Workspace’ button and in the ‘Folder selection’ dialog browse to the
‘CG_Tutorial/src’ folder and click ‘OK’. e” studio formats the path as show in Figure 5-3 below.

Directory:

Add directory path

Sfworkspace_loc/${ProjMNamel/src}

=

oK
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Cancel

] | Workspace... | [ File system...

-

Figure 5-3 Adding workspace search path

Repeat the above steps to add the ‘src/cg_src’ workspace search path. Select ‘Build Project’ from the ‘Project’

-

menu, or use the

button. e” studio will build the project with no errors.

The project may now be run using the debugger as described in 86. The program will display ‘RSKRX231

Tutorial Press Any Switch’ on 3 lines in the LCD display.
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5.3 Switch Code Integration

API functions for user switch control are provided with the RSK. Locate the files rskrx231def.h, r_rsk_switch.h
and r_rsk_switch.c on the RSK Web Installer. These files can be found in the Tutorial project for e? studio.
Copy these files into the C:\\Workspace\CG_Tutorial\src directory. Import these three files into the project in
the same way as the Icd files.

The switch code uses interrupt code in the files r_cg_icu.h, r_cg_icu.c and r_cg_icu_user.c and timer code in
the files r_cg_cmt.h, r_cg_cmt.c and r_cg_cmt_user.c, as described in §4.3.2 and 84.3.3. It is necessary to
provide additional user code in these files to implement the switch press/release detection and de-bouncing
required by the API functions in r_rsk_switch.c.

53.1 Interrupt Code

In the e® studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_icu.h’ by double-clicking on
it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU_IRQ */
uint8_t R_ICU_IRQIsFallingEdge(const uint8_t irg_no);

void R_ICU_IRQSetFallingEdge(const uint8_t irg_no, const uint8_t set_f_edge);
void R_ICU_IRQSetRisingEdge(const uint8_t irg_no, const uint8_t set_r_edge);

/* End user code. Do not edit comment generated here */

Now, open the r_cg_icu.c file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/
* Function Name: R_ICU_IRQIsFallingEdge
* Description : This function returns 1 if the specified ICU_IRQ is set to
* falling edge triggered, otherwise 0.
* Arguments : uint8_t irg_no
* Return Value : 1 if falling edge triggered, O if not
/
uint8_t R_ICU_IRQIsFallingEdge (const uint8_t irg_no)
{
uint8_t falling_edge_trig = 0x0;
if (ICU.IRQCRLirg_no]-BYTE & _04 ICU_IRQ_EDGE_FALLING)
falling_edge_trig = 1;
¥
return falling_edge_trig;
}
/
* End of function R_ICU_IRQIsFallingEdge
/
/
* Function Name: R_ICU_IRQSetFallingEdge
* Description : This function sets/clears the falling edge trigger for the
* specified ICU_IRQ.
* Arguments : uint8_t irg_no
* uint8_t set_T _edge, 1 if setting falling edge triggered, O if
* clearing
* Return Value : None
/
void R_ICU_IRQSetFallingEdge (const uint8_t irg_no, const uint8_ t set f_edge)
iT (1 == set_fT _edge)
ICU.IRQCR[irg_no].BYTE |= _04_ICU_IRQ_EDGE_FALLING;
}
else
ICU. IRQCR[irg_no]-BYTE &= (uint8_t) ~_04_ICU_IRQ_EDGE_FALLING;
}
}
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/
* End of function R_ICU_IRQSetFallingEdge

Function Name: R_ICU_IRQSetRisingEdge

Description : This function sets/clear the rising edge trigger for the
specified ICU_IRQ.

Arguments  uint8_t irg_no
uint8_t set_r_edge, 1 if setting rising edge triggered, O if
clearing

Return Value : None

ook X X % X XN\

void R_ICU_IRQSetRisingEdge (const uint8_t irg_no, const uint8_t set_r_edge)
if (1 == set_r_edge)
ICU. IRQCR[irqg_no].BYTE |= _08_ICU_IRQ EDGE RISING;
}

else

ICU. IRQCR[irg_no].BYTE &= (uint8_t) ~ 08_ICU_IRQ_EDGE_RISING;

N

End of function R_ICU_IRQSetRisingEdge

/

/* End user code. Do not edit comment generated here */

Open the r_cg_icu_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */
/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch._h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_icu_irg4_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Switch 2 callback handler */

R_SWITCH_IsrCallback2();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_icu_irgl_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Switch 1 callback handler */

R_SWITCH_IsrCallbackl1();

/* End user code. Do not edit comment generated here */

5.3.2 De-bounce Timer Code

Open the r_cg_cmt_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */
/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch._h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_cmt_cmil_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Stop this timer - we start it again in the de-bounce routines */
R_CMT1_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();
/* End user code. Do not edit comment generated here */
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In the same file insert the following code in the user code area inside the function r_cmt_cmi2_interrupt ():

/* Start user code. Do not edit comment generated here */
/* Stop this timer - we start it again in the de-bounce routines */
R_CMT2_Stop(Q);

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();
/* End user code. Do not edit comment generated here */

5.3.3 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In 8§4.3.4 we configured the ADC to be triggered from the ADTRGO# pin. In this code,
we also perform software triggered A/D conversion from the user switches SW1 and SW2, by reconfiguring
the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the e” studio Project Tree open the file ‘r_cg_userdefine.h’. Insert the following code the user code area,
resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */
#define TRUE (€D
#define FALSE )

extern volatile uint8_t g_adc_trigger;
/* End user code. Do not edit comment generated here */

Open the file ‘'r_cg_main.c’ and insert #include "r_rsk_switch.h" in the user code area for include, resulting in
the code shown below:

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya_lcd.h"

#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

Next add the switch module initialization function call highlighted in the user code area inside the main()
function, resulting in the code shown below:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSKRX231 ');
R_LCD Display(1, (uint8_t *)'" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
while (1U)
/* End user code. Do not edit comment generated here */
¥

In the same file, insert the declarations in the user code area for global, resulting in the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Prototype declaration for cb_switch _press */
static void cb_switch_press (void);

/* Prototype declaration for get _adc */
static uintl6_t get_adc(void);
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/* Prototype declaration for lcd_display_adc */
static void lcd_display adc (const uintl6_t adc_result);

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* End user code. Do not edit comment generated here */

Next add the highlighted code below in the user code area inside the main() function and the code inside the
while loop, resulting in the code shown below:

void main(void)
{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_Init(Q);

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);

/* Initialize the debug LCD */
R_LCD_Init ;

/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)"™ RSKRX231 ");
R_LCD_Display(1, (uint8_t *)" Tutorial ");

R_LCD _Display(2, (uint8_t *)" Press Any Switch ");

/* Start the A/D converter */
R_S12AD_Start();

while (1U)
{
uintlé_t adc_result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g_adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;

3

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else iIf (TRUE == g_adc_complete)

{

/* Get the result of the A/D conversion */
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Reset the flag */
g_adc_complete = FALSE;

}

/* End user code. Do not edit comment generated here */

3
Then add the definition for the switch call-back, get_adc() and Icd_display_adc() functions in the user code
area for adding at the end of the file, as shown below:

/* Start user code for adding. Do not edit comment generated here */

/

* Function Name : cb_switch_press

* Description : Switch press callback function. Sets g_adc_trigger flag.

* Argument > hone
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* Return value : none

static void cb_switch_press (void)

{

/* Check if switch 1 or 2 was pressed */
ifT (g_switch_flag & (SWITCHPRESS_1 | SWITCHPRESS_2))

/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch_flag = 0xO0;

N

End of function cb_switch_press

Function Name : get_adc

Description : Reads the ADC result, converts it to a string and displays
it on the LCD panel.

Argument I none

Return value : uintl6_t adc value

IR I IR AN

static uintl6_t get _adc (void)
{

/* A variable to retrieve the adc result */
uintlé_t adc_result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R_S12AD_Stop(Q);

/* Start a conversion */
R_S12ADO_SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g_adc_complete)

/* Wait */
}

/* Stop conversion */
R_S12ADO_SWTriggerStop();

/* Clear ADC flag */
g_adc_complete = FALSE;

R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);
/* Set AD conversion start trigger source back to ADTRGOn pin */

R_S12AD_Start();

return adc_result;
by
/

* End of function get_adc

Function Name : lcd_display_adc

Description : Converts adc result to a string and displays
it on the LCD panel.

Argument : uintl6_t adc result

Return value : none

XX % X EN

static void lcd_display_adc (const uintl6_t adc_result)

{

/* Declare a temporary variable */
uint8_t a;

/* Declare temporary character string */
char lcd_buffer[11] = " ADC: XXXH";
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/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (uint8_t)((adc_result & 0xOF00) >> 8);

Icd_buffer[6] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)((adc_result & OxO00F0) >> 4);

Icd_buffer[7] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)(adc_result & 0x000F);

Icd_buffer[8] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd_buffer */
R_LCD Display(3, (uint8_t *)Ilcd_buffer);

N

End of function lcd_display_adc

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_s12ad.h’ by double-clicking on it. Insert the following code in the in the user code area for
function, resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8_t g_adc_complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R_S12ADO_SWTriggerStart(void);

void R_S12ADO_SWTriggerStop(void);

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_sl12ad.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, as shown below:

/* Start user code for adding. Do not edit comment generated here */

Function Name: R_S12ADO_SWTriggerStart

Description : This function starts the ADO converter.
Arguments : None

Return Value : None

L I I N

void R_S12ADO_SWTriggerStart(void)

IR(S12AD, S12ADIO) = OU;
IEN(S12AD, S12ADIO) = 1U;

S12AD.ADCSR.BIT.ADST = 1U;

b4
/

End of function R_S12AD0O_SWTriggerStart

Function Name: R_S12ADO_SWTriggerStop

Description : This function stops the ADO converter.
Arguments : None

Return Value : None

L I I N

void R_S12ADO_SWTriggerStop(void)
S12AD.ADCSR.BIT.ADST = 0U;

IEN(S12AD, S12ADIO) = OU;
IR(S12AD, S12ADIO) = 0OU;
3
/
End of function R_S12ADO_SWTriggerStop

/* End user code. Do not edit comment generated here */

Open the file r_cg_sl12ad_user.c and insert the following code in the in the user code area for global, resulting
in the code shown below:
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/* Start user code for global. Do not edit comment generated here */
/* Flag indicates when A/D conversion is complete */

volatile uint8_t g_adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_s12ad_interrupt () function, resulting in the code shown
below:

static void r_sl2ad_interrupt(void)

/* Start user code. Do not edit comment generated here */
g_adc_complete = TRUE;
/* End user code. Do not edit comment generated here */

}

-

Select ‘Build Project’ from the ‘Project’ menu, or use the button. e” studio will build the project with no
errors.

The project may now be run using the debugger as described in 86. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the Tutorial to add the UART user code.

5.4 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK. Locate the files
r rsk_debug.h and r_rsk debug.c on the RSK Web Installer. These files can be found in the
RSKRX231_Tutorial project for e” studio. Copy these files into the C:\Workspace\CG_Tutorial\src directory.
Import these two files into the project in the same way as the LCD files.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL_DEBUG_WRITE (R_SCI5_AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.5 UART Code Integration

551 SCI Code

In the e studio Project Tree, expand the ‘src/cg_src’ folder and open the file ‘r_cg_sci.h’ by double-clicking on
it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */

MD_STATUS R_SCI8_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

MD_STATUS R_SCI5_AsyncTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

/* Character is used to receive key presses from PC terminal */
extern uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
extern volatile uint8_t g_tx flag;

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_sci_user.c. Insert the following code in the user area for global near the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
volatile uint8_t g_tx_flag = FALSE;
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/* Flag used locally to detect transmission complete */
static volatile uint8_t sci8_txdone;
static volatile uint8_t sci5_txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the r_sci5_callback_transmitend()
function:

static void r_sci5_callback_transmitend(void)

/* Start user code. Do not edit comment generated here */
sci5_txdone = TRUE;

/* End user code. Do not edit comment generated here */

}

In the same file, insert the following code in the user code area inside the r_sci5_callback receiveend()
function:

static void r_sci5_callback_receiveend(void)

{

/* Start user code. Do not edit comment generated here */
/* Check the contents of g _rx char */

ifT (("c” == g_rx_char) || (°C" == g_rx_char))

{

g_adc_trigger = TRUE;
}

/* Set up SCI5 receive buffer and callback function again */
R_SC15_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* End user code. Do not edit comment generated here */

}

At the end of the file, in the user code area for adding, add the following function definition:

Function Name: R_SCI5_AsyncTransmit
Description : This function sends SCI5 data and waits for the transmit end flag.
Arguments : tx_buf -

transfer buffer pointer

t>x_num -

buffer size
Return Value : status -

MD_OK or MD_ARGERROR

Ok X ok X X Ok XN\

/
MD_STATUS R_SCI5_AsyncTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
sci5_txdone = FALSE;

/* Send the data using the API */
status = R_SCI5_Serial_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci5_txdone)

/* Wait */

return (status);

}

/
* End of function R_SCI5_AsyncTransmit

/* End user code. Do not edit comment generated here */
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55.2 Main UART code

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "r_rsk debug.h"

Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for uart_display_adc */
static void uart_display_adc(const uint8_t adc_count, const uintl6_t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8_t adc_count = 0;

Add the following highlighted code to the user code area in the main function:

void main(void)

R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_InitQ;

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);

/* Initialize the debug LCD */
R_LCD_Init Q;

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSKRX231 ");

R_LCD Display(1, (uint8_t *)" Tutorial ");

R_LCD Display(2, (uint8_t *)" Press Any Switch ");

/* Start the A/D converter */
R_S12AD_Start();

/* Set up SCI5 receive buffer and callback function */
R_SC15_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* Enable SCI5 operations */
R_SCI5_Start();

while (1U)
{
uintl6é_t adc_result;

/* Wait for user requested A/D conversion flag to be set */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == ++adc_count)
{

}

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

adc_count = 0;

/* Reset the flag */
g_adc_trigger = FALSE;

by

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{
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/* Get the result of the A/D conversion */
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == ++adc_count)
{

}

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

adc_count = 0;

/* Reset the flag */
g_adc_complete = FALSE;
}

else

/* do nothing */
}

/* End user code. Do not edit comment generated here */

}

Then, add the following function definition in the user code area at the end of the file:

/

* Function Name : uart_display_adc

* Description : Converts adc result to a string and sends it to the UARTL.
* Argument : uint8_t : adc_count

* uintl6é_t: adc result

* Return value : none

/
static void uart_display_adc (const uint8_t adc_count, const uintl6_t adc_result)
{

/* Declare a temporary variable */

char a;

/* Declare temporary character string */
static char uart_buffer[] = "ADC xH Value: »xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char)(adc_count & 0x000F);

uart_buffer[4] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (char)((adc_result & 0OxOF00) >> 8);

uart_buffer[14] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (char)((adc_result & 0x00F0) >> 4);

uart_buffer[15] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (char)(adc_result & 0x000F);

uart_buffer[16] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Send the string to the UART */
R_DEBUG_Print(uart_buffer);

}

/
* End of function uart_display_adc

/
Select ‘Build Project’ from the ‘Build’ menu. e studio will build the project with no errors.

The project may now be run using the debugger as described in 86. Connect the RSK G1CUSBO port to a
USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will now appear under 'Port (COM & LPT)'
as 'RSK USB Serial Port (COMXx)', where x is a number.
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Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI5 (see §4.3.5).
When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC
terminal program via the via SCI5. Return to this point in the Tutorial to add the LED user code.

5.6 LED Code Integration

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "rskrx23ldef.h"
/* End user code. Do not edit comment generated here */

Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for led_display_count */
static void led_display_count(const uint8_t count);

Add the following highlighted code to the user code area in the main function:

void main(void)

{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_Init(Q);

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);

/* Initialize the debug LCD */
R_LCD_Init ;

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSKRX231 ");

R_LCD Display(1l, (uint8_t *)" Tutorial ");

R_LCD Display(2, (uint8_t *)" Press Any Switch ");

/* Start the A/D converter */
R_S12AD_Start();

/* Set up SCI5 receive buffer and callback function */
R_SCI15_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* Enable SCI5 operations */
R_SCI5_Start();

while (1U)
uintlé_t adc_result;

/* Wait for user requested A/D conversion flag to be set(SW1 or SwW2) */
if (TRUE == g_adc_trigger)
{

/* Call the function to perform an A/D conversion */
adc_result = get_adc(Q);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */
if (16 == ++adc_count)
{

adc_count = 0;

led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
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g_adc_trigger = FALSE;

by
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */
else if (TRUE == g_adc_complete)

{

/* Get the result of the A/D conversion */

R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */

if (16 == ++adc_count)
{

adc_count = 0;

led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
3
by

/* End user code. Do not edit comment generated here */

}

Then, add the following function definition in the user code area at the end of the file:

/
* Function Name : led_display_count
* Description : Converts count to binary and displays on 4 LEDSO-3
* Argument : uint8_t count
* Return value : none
/
static void led_display_count (const uint8_t count)
{
/* Set LEDs according to lower nibble of count parameter */
LEDO = (uint8_t) ((count & 0x01) ? LED_ON : LED_OFF);
LED1 = (uint8_t) ((count & 0x02) ? LED_ON : LED_OFF);
LED2 = (uint8_t) ((count & 0x04) ? LED_ON : LED_OFF);
LED3 = (uint8_t) ((count & 0x08) ? LED_ON : LED_OFF);
ks
/
* End of function led_display_count
/

/* End user code. Do not edit comment generated here */

Select ‘Build Project’ from the ‘Build’ menu, or press F7. e’ studio will build the project with no errors.

The project may now be run using the debugger as described in 86. The code will perform the same but now
the LEDs will display the adc_count in binary form.
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6.Debugging the Project

In the Project Explorer pane, ensure that the ‘CG_Tutorial’ project is selected. To debug the project, click the
5 button. The dialog shown in Figure 6-1 will be displayed.

-

Confirm Perspective Switch @

This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective is designed to support application debugging. It

incorporates views for displaying the debug stack, variables and breakpoint
management.

Do you want to open this perspective now?

[ Remember my decision

| Yes | ’ Mo

Figure 6-1 Perspective Switch Dialog

Click ‘OK’ to confirm that the debug window perspective will be used. The debugger will start up and the code
will stop at the Code Generator function ‘PowerOn_Reset_PC’ as shown in Figure 6-2.
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Debug - CG_Tutorial/src/cg_src/r_cq_resetprg.c - €2 studio
File Edit Source Refactor MNavigate Search Project Run  Window Help

8 i P = - AL S AT SR Lo R B A e BRGR <R > R
%5 Debug &7 % v PSS+ V=08 ®Va

4 CG_Tuterial HardwareDebug [Renesas GDB Hardware Debugging]
4 ;@ CG_Tutorialx [1] Narme
4 7 Thread [1]1 (single core) (Suspended : Signal : SIGINT:Interrupt)
= PowerON_Reset_PC() at r_cg_resetprg.c:66 Oxffc00000
i gdb
g GDB server

[€] r_cg_resetprg.c 52
2 56 ffceeeed - void PowerON_Reset PC(void)

1
- #ifdef _ RXV2
ffceeeve set_extb(__sectop("EXCEPTVECT"));
3 #endif
ffceeel7 set_intb(_ sectop("CIVECT"));
- #ifdef _ ROZ /* Initialize FPSW */
#define _ROUND @x00200001 /* Let FPSW RMbits=81 (round to zero) */
- #else
#define ROUND @8x@e280000 /* Let FPSW RMbits=B@ (round to nearest) */
#endif
- #ifdef _ DOFF
.,‘.‘ e e —— o R - .

UL

El Console 32 = Tasks = Renesas Coverage Memory Usage - - Performance Analysis () Profile ﬁﬁg Real-time Chi

CG_Tutorial HardwareDebug [Renesas GDB Hardware Debugging] gdb

monitor set_io access width,RW,1,clc84-clc86,clc94-clc96,clcad-clcab,clcb2,clcb4,clcb6,deeez,dese
monitor set_io_access_width,RW,1,d8120-d8123,d0128-de12f,7fe010,7fe014,7fe013,7fe090,7felde, 7febd

Figure 6-2 Debugger start up screen

For more information on the e? studio debugger refer to the Tutorial manual. To run the code click the U
button. The debugger will stop again at the beginning of the main() function. Press U again to run the code.
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7.Additional Information

Technical Support

For details on how to use e’ studio, refer to
the help file by opening e’ studio, then

selecting Help > Help Contents from the  “Window [ Help

menu bar. LG (ofé:l Wielcome

{(7) Help Contents
7 Search
Dynarnic Help

For information about the RX231 group microcontroller refer to the RX231 Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.
Technical Contact Details
Please refer to the contact details listed in section 9 of the “Quick Start Guide”

General information on Renesas microcontrollers can be found on the Renesas website at:
http://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective

companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics

Europe Limited.

© 2015 Renesas Electronics Europe Limited. All rights reserved.
© 2015 Renesas Electronics Corporation. All rights reserved.
© 2015 Renesas System Design Co., Ltd. All rights reserved.
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